Password Sharing is a Bad Idea

Your supervisor comes into your office and asks you to accompany him/her to his/her office for a discussion about a matter of concern. As you walk down the hall, all kinds of thoughts are going through your head. “What have I done?” “Am I in trouble?” “Am I going to have a job after today?” When you arrive at the supervisor’s office, the head of computer security follows you and your supervisor into the room. The discussion begins, and you are asked about a pornographic e-mail message that was sent to several employees by your logonID. You explain that you did not send this message and you do not know who did. At that point, your reputation is gone and you desperately try to figure out what happened. You have given your logonID and password to a number of people, including temporary employees who are gone. There are many explanations for this incident, but they all point to you.

Whenever a user on the computer system sends an e-mail message or opens, deletes, or copies a file, this information is logged or attached to the message or file. Therefore, it is very important that you are the only person who uses your logonID.

The state policy regarding logonIDs states that “logonIDs must not be shared”. When a user shares their logonID and password, it can be used for things that were not intended. It gives unintentional access to areas that others may not generally have access to, and can eventually get you in trouble.

In the example above, this user could have given his or her logonID and password to someone else, such as a temporary employee or contractor, who could have sent the e-mail message. These types of people are long gone when the security breach is discovered. A hacker, someone that figured out the logonID and password could have also sent the message. Hackers find out personal information about users to figure out passwords to gain illegal access to computer systems. This is why it is very important to keep your logonID and password to yourself as well as the need to have a good password.

State policy regarding passwords states:

- Passwords will be at least 6 characters long and contain at least one numeric and one alphabetic character.
- Passwords will be changed at least every 60 days.
- Passwords will not be reused for at least 4 cycles.
- Passwords will not be written down where they can be found by unauthorized personnel and should not be shared with other individuals.
- Passwords should not be obvious or easily guessed (logonID, user’s name, address, birth date, child’s name, spouse’s name, etc.)

Continued on next page
It is also important not to give out any personal information about yourself when you are accessing the Internet. Users have become streetwise by growing up in the real world, but the Internet is so new that they have not had time to get cyber-streetwise. You would not stroll down a dark alley with money hanging out of your pocket or leave the door to your house unlocked. Too many users do the electronic equivalent every time they surf the Internet. They leave information on the Internet about themselves that hackers can easily access. The hacker then uses this information to gain access to computer systems.

The employee mentioned earlier was never cleared of the accusation of sending the e-mail message (sorry, but the story does not have a happy ending). This user immediately changed their password and never gave it out again.

For more information regarding security policies or computer hackers, contact Lynne Pizzini, ISD Network Security Officer at 444-4510, ZIP! or e-mail at lpizzini@mt.gov.

**New International Calling Rates**

Beginning on April 1, 1998, a new rate structure went into effect for International Direct Distance Dialing (IDDD) calling on the State Telephone Network. Prior to that, the rates charged for IDDD calls were based on a commercial tariff filing provided by Telco Research, and discounted by 30% in our management system, to calculate the cost. These rates also were worked out in three different calling periods depending on time of day, and had a cost for the initial minute of use, and usually another rate for additional minutes. This made it difficult for agencies and university students to estimate costs. The goal, therefore, was to come up with lower rates, based on the State's actual cost per minute, and at the same time to simplify rates to make it easier to understand and calculate costs for marketing purposes at the universities for the Student Long Distance program. The result has achieved just that. The new rate structure features a flat per minute rate, and is broken out in two calling periods “peak” and “off-peak” which reflects our actual contract with AT&T for international calling.

Here are some sample call cost comparisons for an average (7.5 min.) international call.

<table>
<thead>
<tr>
<th>Country</th>
<th>New IDDD Costs</th>
<th>Old IDDD Costs</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Peak Period</td>
<td>Standard Period</td>
</tr>
<tr>
<td>Costa Rica</td>
<td>$7.56</td>
<td>$10.08</td>
</tr>
<tr>
<td>Germany</td>
<td>$4.72</td>
<td>$8.75</td>
</tr>
<tr>
<td>Japan</td>
<td>$5.89</td>
<td>$10.78</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>$8.80</td>
<td>$11.29</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>$3.62</td>
<td>$7.35</td>
</tr>
</tbody>
</table>

If you have any questions, or would like further information on State Network calling rates, please contact Dan Kelly in the Telecom Voice Operations group at 444-2730, ZIP! or e-mail at dkelly@mt.gov.
Montana State Government agencies are continuing to make deliberate progress towards correcting computer systems so they will operate properly in the 21st century. As of June 3, there were 694 computer systems being tracked for Year 2000 (Y2K) compliance. Agencies planned on having 281 of these systems compliant by July 1, 1998 and 276 of them were compliant on June 3, 1998. The chart below shows Montana's progress compared to our own projections. We have made significant progress but still have more than half of the systems left to fix.

However, some Federal agencies are not fairing well in meeting their Year 2000 objectives. Representative Stephen Horn, R-California, Chairman of the House Subcommittee on Government Management, Information, and Technology, recently released grades on the Federal Government's progress toward solving the Year 2000 computer problem. Each of the Government's 24 largest departments and agencies received a grade primarily on the basis of when its mission-critical computer systems will become Year 2000 compliant. Four additional criteria are used in grading:

- contingency planning
- telecommunication systems
- embedded microchips
- external data exchanges (when agencies share data with other entities including the State of Montana).

Mr. Horn made the following statement upon releasing the grades: “Overall, the Federal Government earned an 'F'. Underlying this dismal grade is a disturbing slowdown in the Government's rate of progress. For the quarter ending February 15, the Government brought mission-critical systems into compliance at a rate of 9.4 percent; for the quarter that ended May 15, the rate of progress slowed to 7.9 percent. This would be discouraging in any context. Less than a year before the March 1999 deadline for Y2K repairs, a reduction in productivity is deeply troubling. This trend must be reversed.” Montana is very concerned about Year 2000 compliance in the various Federal agencies that exchange data with the State and has been working closely with the Federal government to identify those systems involving any electronic data exchange between federal and Montana State agencies. This effort has been spearheaded by the National Association of State Information Resource Executives (NASIRE) and represents a significant effort to insure that not only are Montana computer systems Year 2000 compliant, but just as importantly those systems at the federal level are equally free of century crossover issues. This will be an ongoing effort for several months.


For more information on the Year 2000 problem, contact G. Scott Lockwood of the Policy, Development & Customer Relations Bureau at 444-2655, ZIP! or e-mail at slockwood@mt.gov.

Year 2000 Compliance for All Systems
Target vs Actual

<table>
<thead>
<tr>
<th>Year 2000 Compliance for All Systems</th>
<th>Target vs Actual</th>
</tr>
</thead>
<tbody>
<tr>
<td>1997</td>
<td>243</td>
</tr>
<tr>
<td>Q1 98</td>
<td></td>
</tr>
<tr>
<td>Q2 98</td>
<td></td>
</tr>
<tr>
<td>Q3 98</td>
<td></td>
</tr>
<tr>
<td>Q4 98</td>
<td></td>
</tr>
<tr>
<td>Q1 99</td>
<td></td>
</tr>
<tr>
<td>Q2 99</td>
<td></td>
</tr>
<tr>
<td>Q3 99</td>
<td></td>
</tr>
<tr>
<td>2000</td>
<td></td>
</tr>
</tbody>
</table>

[Chart showing Year 2000 Compliance for All Systems]

- Target Compliant
- Actual Compliant
PeopleSoft is Now Montana Specific!

With agencies’ help in the Joint Application Design (JAD) sessions, the MT PRRIME Team has documented Montana’s requirements, noted places where the software failed to meet those requirements, and developed a list of modifications to the software to address those deficiencies.

This effort provides a first look at how the software will support our business processes.

Following is a general overview of the benefits of PeopleSoft. Also, since the first PeopleSoft Module to be utilized is Asset Management, we have provided an outline of the features and functionality it will bring to Montana.

A complete report of the entire module’s features and functionality can be found on Montana’s Web site at http://www.mt.gov/DOA/mt_prrime/montpri.htm.

System-Wide Benefits

- **Effective-dated data.** Information in PeopleSoft is managed through the use of Effective Dates. This means that, for every row of data on the system, you are able to specify the date the information takes effect. This has several benefits:
  - **History Information.** Because old data rows are retained even as new ones are added, we will no longer ‘lose’ history data when we update the system. This also allows the users (and the system) to see what things looked like on a particular date in the past. For example, you would be able to tell what your pay rate was for any given date in the past, no matter how many times it had changed since.

- **Future Dated Rows.** Because we can put new rows on the system before they are effective, we are able to perform data entry before an event occurs, rather than waiting for it to happen. This will be helpful for updating the system with new pay rates for employees as soon as they become available, rather than having to wait until the last pay run before they are in effect.

- **Easy Access/Same Panels.** The consistent use of effective dates across all panels (in update and inquiry modes) lets the users consistently take advantage of this feature.

- **Consistent user interface across modules.** Because the software is developed on the same platform across all modules (Financials and HRMS), it uses a consistent interface for accessing and using the panels. Much like the Windows environment, learning one application enables the users to quickly learn another. No longer do users have to learn mainframe, client-server, and other systems they may be using now for all the different functions. Because PeopleSoft will be widely used for financial and human resource functions across state agencies, users are guaranteed their PeopleSoft skill set will be applicable at their new agency.

- **Central data source.** The use of a central data repository eliminates the need to have to update data separately for each function. For example, an address change in HR is reflected in Benefits and Payroll as well. The same is true for Purchasing and Accounts Payable. This central data source enables the integration between the modules to be more tightly linked, such as the ability of the system to update payroll information with a change of address.
- **Improved reporting.** The consistent user interface will enable users to access reports in a consistent manner, as well as have the option of viewing reports on-line or in a paper format. Furthermore, we’ll be able to download information from the core system and manipulate it using Excel and Word, right at our desks. The power of a relational database for our core financial information, available to only a few Montana agencies right now, will allow all agencies a more robust reporting environment.

- **Real-time information.** Batch processing is significantly reduced in the client-server environment. With the exception of jobs that require major computer resources (Payroll, for example), most data can be updated and jobs run on-line, during the day. This will improve the timeliness of the information available to the users.

- **Implementation of standard “best practices” procedures.** The PeopleSoft Software has been designed with industry “Best Practices” in mind. Learning from the experience of their many public and private sector clients, the software has efficiencies and features that are already ‘built-in’ that have not had to be designed from scratch here in Montana.

- **Supported software package.** As long as the state remains on a maintenance contract with PeopleSoft, we will continue to be supported by the software vendor. This entitles us to free upgrades and improvements in the software, help-line support, and a PeopleSoft Account Representative to answer our questions and help us with any problems we may encounter after implementation.

- The fact is, the development environment is too expensive for every public entity to be developing its own systems. Will SBAS and PPP ever be client server systems? No. Will SBAS and PPP ever be written in a relational database? No. Will SBAS and PPP ever be web accessible? Probably not. But the next release of PeopleSoft (7.5) provides web access—something we could not afford to provide on our own. Traveling state employees will be able to access our financial and human resource systems.

The benefits of the Asset Management module include:

- Elimination of redundant data entry through integration of the Asset Management System with Payables, Purchasing and the General Ledger.

- Provide paperless asset processing and the elimination of the need for external keypunch functions.

- Provision of on-line addition, transfer and retirement functions to all state agencies (except the University system).

- Maintenance of a complete cost history for state assets.

- Allows the tracking of all state assets, both capital and non-capital, depreciable and non-depreciable. Posting of depreciation to the General Ledger is automatic and additional flexibility in depreciation methods is provided

- Provides the capability to account for both operating and non-operating leases.

- Capital acquisition plans can be developed and tracked on the system.

- Provides the platform for a statewide barcode inventory system.

- Asset repair, service and maintenance history can be tracked.

- Provide adequate asset detail including custodian, location, licensing and registration information.

- Maintain capital and operating leases and monitor maintenance contracts.

- Calculate and post capital lease entries to the general ledger.

- Develop payment schedules for both straight line and variable payment leases.

- Efficient asset additions through the use of asset profiles and the asset copy function.

- Perform inflation analysis.

**Issues**

Asset Management will not interface with other PeopleSoft financial modules until 7/1/99.

For more information contact Anita Varone of MT PRRIME at 444-2013, ZIP! or e-mail avarone@mt.gov.
IBM BookManager Read/MVS

BookManager READ/MVS is a program that helps you use any online books that you have access to, directly from the mainframe. Using BookManager READ/MVS panels, windows, and function keys, you can display and search online books quickly and easily, while in ISPF. BookManager has links directly from SDSF, that allow you to jump directly into BookManager, perform a search and come directly back to SDSF.

IBM and many third party software vendors provide online manuals in BookManager format. Currently we have loaded manuals covering the OS/390 operating system and its components, CICS manuals, as well as many Computer Associate manuals.

As of July 1, BookManager can be accessed from the primary ISPF panel by selecting option ‘B’. Every time you enter BookManager, you will see the IBM copyright screen first, just press ‘Enter’ to continue.

First Time Setup

The first time in BookManager (Option B), you need to add the default bookshelf. To do this, go up to the command line and select BOOKS, then option 6. ‘Perform file functions...’, then select 5. ‘Add...’.

On the ‘Add a Bookshelf to a Bookshelf List’ panel, type the following data set name ‘SYST.BKMG.DEFAULT.BKSHELF’ and press enter. This default bookshelf will provide access to most, general-purpose manuals supplied by IBM and other software vendors. If you do not find a particular manual, call or e-mail Tom Clement in Technical Services (444-2881, tclement@mt.gov) to check availability.

BookManager searches from SDSF

In order to enable the search capabilities of BookManager from SDSF, you must first complete the procedure above and then from within SDSF, perform the following:

Enter ‘S.H’, then go up to the command line and select Options.

Select option 4, on the Bookshelf line enter ‘DEFAULT’ and press enter.

It is suggested that you setup a PFK key to issue the BOOK command, as it allows quick and easy searches from within SDSF. You can modify the SDSF PFK keys via OPTIONS, selection 10. Choose the PFK key you want to use and type BOOK. This will issue the BOOK command when you press that PFK key.

Now you can enter a search word or phrase on the command line and press the PFK key or place the cursor under a phrase and press PFK key. This will trigger a BookManager search.

It will display a list of books containing the selected message or phrase. Select the book you wish and press enter. This will then list the topics containing the message or phrase. To select a topic, tab to the topic and press ENTER.

To return to SDSF, press PFK12 and close books and shelves as prompted.

Should you have questions, or would like a copy of expanded instructions, regarding BookManager, please contact Tom Clement, Technical Services, ISD at 444-2881, ZIP!, or e-mail at tclement@mt.gov. We would also welcome your feedback on this product, especially if you are familiar with and use IBM Library Reader.

Error in last month’s article. Last month in the VSAM Data Sets and the R/A article it stated “There is no longer any benefit to use the EMBED or REPLICATE parameter on an IDCAMS DEFINE statement for a VSAM file.” It should have read “There is no longer any benefit to use the IMBED or REPLICATE parameter on an IDCAMS DEFINE statement for a VSAM file.”
Advisory Groups on the Web

Information on the advisory groups that assist the Information Services Division in delivering services to the Montana enterprise can be found on the ISD website at http://www.state.mt.us/isd/groups.

Membership, minutes and more is available on these Councils:

- Information Technology Advisory Council (ITAC)
- Information Technology Managers Council (ITMC)
- SummitNet Executive Council (SEC)
- 9-1-1 Advisory Council
- Montana Public Safety Communications Council (MPSCC)
- Montana Geographic Information Council (MGIC)

For additional advisory group information, contact Wendy Wheeler of ISD at 444-2856. ZIP! or e-mail at wwheeler@mt.gov.

ITAC Prioritizes Enterprise Budget Initiatives

The Information Technology Advisory Council (ITAC) met on May 27, 1998. As budget preparation for the 1999 Legislative Session continues, ITAC members prioritized several programs offered by the Information Services Division under the Data Network Connectivity Rate. The top three items are Data Network Growth, Central Administration and Funding of Desktop Software and Network Operating System Support. ISD is proposing other initiatives recovered through other methods and funds. These include Enterprise MidTier Support, the MT PRRIME Operational Bureau, Phase III of the Public Safety communications Project, continuation of the Statewide GIS Cadastral Database project, and Implementation of the SummitNet Telecommunications Plan.

ITAC also took action on the recommendations in the ITMC Report on Recruitment and Retention of State Information Technology Professionals. They approved recommendations to continue the existing pay exception for IT professionals, support a market-based IT broadbanded pay plan based on efforts currently underway in the State Personnel Division and look at non-compensatory strategies to aid in recruiting and retaining IT personnel.

Minutes of the meeting are available on the VAS \guest\itacinfo\minute98 or on the ISD website at http://www.state.mt.us/isd/groups/Itmc.

ITMC Elects New Officers

By unanimous vote, Hank Trenk of Legislative Services Division was elected to fill the position of Chair of the Information Technology Managers Council. Hank has been an active member of the group and recently completed a one-year term as Vice Chair. The newly elected Vice Chair is Robert LaRue, Department of Agriculture. New Executive Board Members are Tori Hunhauzen, Legislative Audit Division and Daniel Forbes, Public Health and Human Services. Congratulations.

Many thanks to outgoing chair Mike Randall of the Department of Transportation who led the group through a successful refocusing, major decisions in desktop software and database standards and a close look at recruitment and retention of IT professionals in state government.

Larry DeFrance, Art Pembroke and Gregg Wheeler have devoted countless hours to ITMC issues and we thank them for their invaluable participation on the ITMC Executive Board.

In other business at the June 3 meeting, the Council was updated on the MT PRRIME project, the e-mail project, the status of imaging services in state government, and the Year 2000 issue.

Minutes of the meeting are available on the VAS \guest\itacinfo\minute98 or on the ISD website at http://www.state.mt.us/isd/groups/Itmc.
Oracle Designer/2000

What is the Process Modeller?

Oracle Designer/2000 is a product for modeling the business processes of an enterprise in order to re-examine the methods used to achieve the goals of the enterprise. Typically, this can result in improved systems that remove redundant activities and optimize the use of resources.

It is a tool for creating and maintaining business process models, and providing animation and multimedia features. The resulting process diagrams are stored within the Repository. The process diagram illustrates a particular business process.

Basic Features of the Process Modeller

Process Modeller produces a process diagram. This is done by drawing the process as a diagram on the screen, then choosing from a library of predefined symbols. Each symbol on this process diagram represents a particular stage of the process being drawn. Symbols are provided to represent the various types of diagram element, which are:

- **Organization Unit** – business division, department or unit responsible for a stage
- **Process Step** – a task, activity or function that represents a stage
- **Flow** – the movement of data or materials between stages using a critical path
- **Store** – a collection of information or materials used in the process
- **Trigger** – an event that initiates the process
- **Outcome** – an event that results from the process

Creating a Process Flow Diagram

1. Click on the Process Modeller icon.
3. Select the appropriate item from the list (Note: You must have a tiled application in the Repository Object Navigator.)
5. Click on the Create Organization Unit icon, then click in the Unspecified area. The Create Organization Unit dialog box appears. Type in the appropriate name and press OK. Do this step until all the units appear on the diagram.
6. Click on the process step box, then click in the swim lane of the Organizational Unit. Type in the appropriate name and Press OK. Do this step until all the process stages are complete and in the correct swim lanes of the each Organizational Unit.
7. Click on the Create Flow icon, then click the process step that will begin the flow, and click on the next process step in the data flow. Type in the appropriate name. Do this step until all the flows are complete.

To exit from the Process Modeller

Select File | Exit or press CTRL+Q

If the Process Modeller contains any named diagrams with unsaved changes, this option displays a message for each diagram asking whether to save the changes. Yes will save the changes. To close only the active diagram without exiting from the Process Modeller, select File | Close.

For information or assistance on using Oracle Applications, contact the Systems Support Bureau: Barry Fox at 444-5895, ZIP! or e-mail at bfox@mt.gov; Steven St. John at 444-2910, ZIP! or e-mail at sstjohn@mt.gov; Tony Noble at 444-2922, ZIP! or e-mail at tnoble@mt.gov.
ZIP! Attachments- Does it take too long?

You have seen some sluggish response time when it comes to sending attachments to multiple people within multiple offices. For example, let’s say that Jane Zip is trying to send a report to ten different offices within the XYZ agency. Each of these offices contains ten employees. When Jane sends this ZIP! message and attachment she is actually sending 100 messages and 100 copies of the attachment! That’s quite a load of network traffic. Depending on the size of the attachment, Jane could actually cause mail to be backed up for quite some time. The recommended solution for this scenario is for Jane to send the message and attachment to one person in each of the ten offices. Now she’s only sending a total of 10 messages. Once the message reaches each office, the recipient can then elect to either forward the message to his/her co-workers or simply copy the file out to a shared drive on the network. With the file on the shared drive, the recipients can notify others that the file is available. This method of sending out one message per office will alleviate excessive traffic on the Wide Area Network and will make not only the sender and receivers happy, but will also please the network itself and the support staff.

For additional information or questions regarding this article, please contact Lisa Carson of End User Systems Support at 444-1542, ZIP! or e-mail at lcarson@mt.gov.

E-Mail Project Update

The E-mail Implementation Team is on track with the planning phase of the project to bring Microsoft Exchange/Outlook to all state e-mail users. As the Team moves into the conceptual design for the Exchange infrastructure, testing results are crucial. Load simulation testing is underway to help determine bandwidth needs and connections to ZIP!/Mail/Office and EMC²/TAO are in place and working fine. As a result, as we convert to the new e-mail system, you will still be able to communicate to users using the old systems. The Testing Team is also taking a hard look at the Outlook Web Access Client, however, they are finding that this client has many limitations and may not be a good solution for roaming, mobile and dial-in users.

We are striving to provide calendar migration from ZIP!Office, but there will not be Intray/Outtray migration. Keep working on cleaning up your folders and Intrays!

The Team anticipates conducting pilots during the summer and beginning general rollout in September. For questions on the Team’s activities, contact Wendy Wheeler, 444-2856, ZIP! or e-mail at wwheeler@mt.gov.

Outlook 98 Update

Messaging coexistence

A major concern among State employees is not being able to communicate with those users not yet converted to the Outlook e-mail system. The Microsoft Exchange Testing Team has done much work in this area - testing messaging coexistence between Outlook 98 and ZIP!Office/ZIP!Mail as well as from Outlook 98 to EMC²/TAO and vice versa.

Put your mind at ease! Testing is almost complete in this area and it is working well. Messages sent from Outlook to ZIP! appear in the ZIP! Intray as an attachment, even though it is a message. Currently, if you correspond with EMC²/TAO users, anything received from them also appears as an attachment although it is actually a message.

The E-mail Implementation Team is committed to a smooth transition for State government’s end-users. As the testing continues you will be updated on the Team’s progress in future ISD News & Views articles.

If you have any questions or concerns regarding the migration to Outlook98, please contact Sue Skuletich of the End User Support Section at 444-1392, ZIP! or e-mail at sskuletich@mt.gov.
PowerPoint Made Easy!

Presentation Tips

Most presentations consist of someone standing in the front of a room and delivering a message to those seated. A slide comes up, the presenter says some words, next slide, more words etc. At the end of the presentation, questions are fielded. These monologues closely resemble a classroom situation and often are not the best way to keep an audience's attention. It becomes a drone. A better presentation is to engage the audience, turning the monologue into a dialogue. Here are some suggestions:

- Know the names of some or all of the participants. “Bill, let's say you call Karen and she doesn't have Voice Mail. What do you do then?” This type of dialogue involves the audience and they will pay more attention. It also brings your message closer to home.

- “How many of you have ever left a Voice Mail message for someone but you weren’t sure if they were even in the office that day?” If you ask a question like this while raising your hand you will encourage a response. This is like taking a mini poll. It also gives you a good idea where your audience is at in respect to your presentation.

- Ask for volunteers. Two people demonstrate what it's like to play phone tag. Add another person who is the message taker.

But, before you give the presentation, you have to create it. In past issues of ISD News & Views we worked on opening a presentation and creating a title slide (April, 1998), text slides (May 1998) and organization charts (June 1998). This month we’ll explore Tables.

Tables are very useful for showing and comparing data. When working with Tables, having the Table Toolbar available will save time. If it is not already available you can bring it up by going to View | Toolbars | Tables and Borders. By putting the cursor on the right side of the box a double arrow will appear. Drag to the right and all the icons will be on one line. Drag and drop the toolbar under the formatting toolbar at the top of the window.

If you are following this series, open the presentation we've been working on and a new slide. In Autolayout choose Table (top row, far right), double click on the Table placeholder and notice the dialog box that appears.

For this table we’ll create eight columns and two rows. Type 8, Tab, Type 2 and Enter. The blank Table is now ready for data. We'll first enter the data and then reformat later, so if the data wraps or is the wrong font or size we’ll correct it then. Type Jul91, tab, Jul92, tab, Jul93, tab, Jul95, tab, Jul96, tab, Jul97, tab, Jul98, tab Jul99 to complete the first row. Move the cursor to the second row by hitting another tab or use the mouse. Type 200, tab, 717, tab, 1,174, tab, 2,453, tab, 3,010, tab, 3,161, tab, 3,400, tab, 3,550.

To format the table, click on the Autoformat icon. Autoformat is a quick and easy way to format tables.

Use the down arrow and watch the Preview box change with the different formats. Stop at “3D Effects 3” and then hit OK.

To format the text and cell size:

- Select all the data by clicking and dragging from bottom right to top left.
- Change the font size to 26.
- Slowly move the cursor to the top of the second row and see it turn to a double arrow.
- Click and drag up toward the top row and release the mouse button when the spacing is to your liking.
- Repeat the click and drag with the bottom of the second row.
- Click and drag the bottom middle handle of the Table up to just below the last row.
Select the top row and then hit the B (bold) icon on the formatting toolbar.

Select the second row and hit the Center icon.

Select the Title Bar and type Voice Mail Annual Growth

Save the presentation

The previous example is just one of many options. For another, select the table, go to Draw|Ungroup and format the individual pieces of the table but you will lose all linking. You can change fonts, font colors, shading, lines, line weight and color. In addition you can massage the data by sorting and other options. Take some time to explore.

Next month we'll tackle Graphs.

For more information about this article contact Trapper Badovinac of the Policy, Development & Customer Relations Bureau at 444-4917, ZIP! or e-mail at tbadovinac@mt.gov. For user support, contact the Customer Support Center at 444-2000.

---

RegClean

Windows 95/NT Freebie

This month's free utility is drawn from the Microsoft download archives. It is actually a reissue of a freebie released in March of 1997 and then later recalled due to problems in the code. Below are excerpts from the readme file that comes with the program.

RegClean analyzes Windows Registry keys stored in a common location in the Windows Registry. It finds keys that contain erroneous values, and after recording those entries in the Undo.Reg file, it removes them from the Windows Registry. RegClean does not fix every known problem with the registry. It does not fix a "corrupt" registry; it only fixes problems with some of the entries that are in a normal registry. It is very possible that RegClean will not correct a problem that you have encountered. RegClean will leave any entries in the registry that it doesn't understand or could possibly be correct.

If you would like a copy of RegClean, the files are available on the ISD Value Added Server at \guest\windows\winaddon\95addons\regclean. If you don't access to the VAS, contact Denny Knapp of End User Systems Support via ZIP!, at 444-2072, or at dknapp@mt.gov
Can I share files with co-workers who aren't using Office 97?

Although you've upgraded to Microsoft® Office 97, your co-workers are still using earlier versions of Office programs (or different programs altogether) and are unable to open your files. To complete your projects and keep working efficiently, you need an easy way to share files with your co-workers. Fortunately, Office programs make it easy to save files so that a wide range of users can open and use them.

If your co-workers are working with earlier versions of Office programs, they will not be able to open your files unless you specify the version format before you save the file. To save files in a previous version format in Microsoft Word, Microsoft Excel, or Microsoft PowerPoint®, specify the version format by using the File | Save As command on the menu. In the Save As type list, select the version you want to save the file in. You should select the version that's installed on your co-workers' computers.

If your co-workers are using non-Office programs, they may not be able to open your files unless you save them in a different file format. To do this, specify the file format by using the File | Save As command. In the Save As type list, select the file format you want to save the file in. You should select a format that can be opened by both programs. In the Save As dialog box, specify the file name and folder location for your file, and then click Save. Note that some programs have features that will automatically save files while you work on them (such as Fast Save in Word or AutoSave in Excel). If you're working with these features turned on, you still need to save the file using Save As before sharing.

Be aware that there are several problems that can occur when sharing documents with individuals or agencies who are not yet using Office 97 products. Refer to “Converting WordPerfect/Lotus/Freelance Documents to Office 97” for problems to be aware of.

This article is reprinted in part from an article written by Riki Shore (www.microsoft.com/office/office/assistance/OFshfile.asp?prev=111111). For more information, contact Irvin Vavruska of End User Systems Support at 444-6870, ZIP!, or e-mail at ivavruska@mt.gov. For questions about Office 97, please contact your agency support staff, Office 97's Help Features, or the ISD Customer Support Center at 444-2000.

---

Converting WordPerfect/Lotus/ Freelance to Office 97

In general, legacy documents that do not contain advanced features of the original software (such as embedded graphics, tables, table of contents, etc.) will convert reasonably accurately when opened in the new Office 97 programs. However, there are several problems that users should be aware of. The following comments are not meant to provide an all-inclusive list of the problems, but are merely a list of the more obvious problems that users will encounter.

- **Documents created with Word 97 cannot be viewed in ZIP!Office.** There is no Word 97 viewer in ZIP!Office. When sending attachments to users in other agencies, send the documents in WordPerfect 5.1 for DOS or plain text format unless you know for certain that the intended recipient(s) have Word 97 and know how to save a ZIP!Office Attachment to disk so it can be read.

- **If it is necessary to convert a Word 97 document to WordPerfect format, save the document in WordPerfect 5.1 for DOS format.** (Please note that if you choose the WordPerfect 5.x for Windows format, rather than the WordPerfect 5.1 for DOS format, the file will cause ZIP!Office to abend if you send it as an attachment.) There is no option to save Word 97 documents in WordPerfect 6.x format. However, you can save the Word 97 document in WordPerfect 5.x format and then open the WordPerfect 5.x document in WordPerfect 6.x.
Understanding Word

Part 3 - Macros

The Visual Basic Editor: A Basic Roadmap

The heart of the macro feature in Word is the Visual Basic Editor. Before undertaking any conversion project, become well acquainted with the editor. The more you know about the editor, the faster and more successful you will be in converting WordPerfect macros.

Open the Visual Basic Editor by pointing to Macro on the Tools menu, and clicking Visual Basic Editor (or press ALT+F11). The editor, shown below, consists of a menu bar, a toolbar, and several windows.

- The Project Explorer window displays all of the projects available for editing. (A project is analogous to macros stored in a WordPerfect template.)
- The Properties window displays all of the properties of the selected item. For example, when a command button on a form is selected, the Properties window shows options for the command button.
- The Code window displays the content of the current macro.

Other windows may appear depending on the options you've selected. For example, click Object Browser on the View menu to display a list of objects, properties, and methods you can use. Objects, properties, and methods can be combined to create Visual Basic instructions which are akin to programming commands in WordPerfect.

Note: If you’re having trouble with the layout of a document you’re converting from WordPerfect 6.x to Word 97, try reopening the document in WordPerfect 6.x. Press CTRL+END or scroll to the end of the document, and save the document again in WordPerfect 6.x format before opening it in Word 97.

For more information concerning this article, contact Irvin Vavruska of End User Systems Support at 444-6870, ZIP!, or e-mail at ivavruska@mt.gov. For questions about Office 97, please contact your agency support staff, Office 97's Help Features, or the ISD Customer Support Center at 444-2000.
Understanding the Terminology of Visual Basic

Visual Basic uses a different set of programming terms than those used in WordPerfect. In Visual Basic, tasks are performed by applying properties and methods to objects. Objects are the fundamental building blocks of Visual Basic; almost everything you do in Visual Basic involves modifying objects. Every element of Word — documents, paragraphs, fields, bookmarks, and so on — is represented by an object in Visual Basic. To view a graphical representation of the object model for Word 97, see “Microsoft Word Objects” in Word Visual Basic Help. If you’re not familiar with the terms object, properties, and methods, refer to the “Understanding objects, properties, and methods” topic in Word Visual Basic Help.

You can view the available objects, properties, and methods in the Visual Basic Object Browser. To see the Object Browser, display the Visual Basic Editor, and click Object Browser on the View menu. Select a library in the Project/Library box. The Word object library contains all the objects, properties, and methods (analogous to “commands” in WordPerfect) you need to write code using Visual Basic.

Comparing Syntax

Visual Basic and the WordPerfect macro language are very different. The differences of syntax between the two languages encompass the actual programming commands, and the way the commands are formatted to construct a working application.

Differences in syntax are the major stumbling block in converting WordPerfect macros to Visual Basic. For a table that lists the major differences you will encounter when converting WordPerfect macros to Visual Basic, see the ISD News & Views website at http://www.state.mt.us/ISD/current/news/July98/macro.htm.

Recording Macros to Learn Syntax

If you are fairly new to Visual Basic, a good way to learn Visual Basic syntax is to record a simple macro in Word. You can then examine the resulting Visual Basic code in the Visual Basic Editor.

1. In a blank Word document, start recording a macro by pointing to Macro on the Tools menu, and then clicking Record New Macro.
2. In the Record New Macro dialog box, type testing as the name of the macro, and click Record.
3. In the Word document type This is a test, press ENTER, and then click OK.
4. Stop recording by pointing to Macro on the Tools menu, and then clicking Stop Recording.

The macro is now recorded, and can be viewed in the Visual Basic Editor. To view the macro:

1. Point to Macro on the Tools menu and then click Macros (or press ALT+F8).
2. Select testing under Macro name.
3. Click Edit.

For more information on recording a macro, see “Recording a macro to generate code” in Word Visual Basic Help (use the Find tab to locate the topic).
The recorded macro appears in the code window as:

Sub testing()
'
' testing Macro
' Macro recorded 03/26/97 by Steve Masters
'
Selection.TypeText Text:="This is a test"
Selection.TypeParagraph
End Sub

The macro begins with a subroutine name, which by default is the same as the macro name. Comments (indicated by an apostrophe (')) provide a short description of the name of the macro, when it was recorded, and by whom. The actual recorded contents of the macro follow, and, in this case, consists of two commands:

Selection.TypeText Text:="This is a test"
Selection.TypeParagraph

The Selection.TypeText command specifies that text is to be inserted into the document. The Selection.TypeParagraph command specifies that a hard return is to be inserted in the document.

For comparison purposes, the same macro recorded in WordPerfect 5.1 for DOS appears in its macro editor as:

{DISPLAY OFF}
This is a test {Enter}

And in WordPerfect 6.1 for Windows:
Type (Text:"This is a test")
HardReturn()

As you can see, the syntax between these three word processors is vastly different, with thousands of possible permutations. Since it is impossible to enumerate all the differences between the macro languages, it's generally easier to record new macros in Visual Basic, and use the new recordings as a basis for your new Word macros.

For more information contact Jerry Kozak End User Systems Support at 444-2907, ZIP! or e-mail at jkozak@mt.gov. For Word 97 help please contact Customer Support at 444-2000.

---

**Changing Document Suffixes in Word**

Word 97, unlike WordPerfect, allows the use of long filenames. Long filenames are any files that have names over eight characters, not counting the suffix (the three letters after the period.) Word 97 will assign the default suffix (.doc), and WordPerfect will assign (.wpd) if no other suffix is used.

Using the traditional suffix allows easy distinction between Word, WordPerfect, Excel or Lotus Files. This is especially important during the conversion because of the mix of both old (Word Perfect/Lotus) and new (Word/Excel) files.

In WordPerfect you can easily use the three characters after the dot to further identify the file. Since Word 97 uses long filenames it becomes unnecessary to use the suffix for naming. To use a suffix other than the default in Word 97, simply enclose the file and the extension in quotes.

For example, a file saved as Temp.bjc would be written with the default extension as Temp.bjc.doc. To avoid this, save as “Temp.bjc”.

If you have questions regarding this article please contact Brian Clark at 444-0751, ZIP! or e-mail at brian@mt.gov.
Media Based Training

Many of us have a need for technical training but find it difficult to find a block of time to devote to it. Self-paced study programs solve many of these problems. ISD has a library of courses available. Each month ISD News & Views will review a course or series.

- **A VCR is needed.** Most of the courses are delivered on video, but some are multi-media on CD ROM. The information is presented in a very professional manner using various teaching methods including diagrams and real life examples. The accompanying workbook provides the course in written form and after each section quizzes you on what has been covered.

- **Sign up.** Contact Trapper Badovinac or Diana MacDonald via ZIP! to request a course. They will need your name, phone number and Agency.

- **Pickup.** You can pick up the course in Room 222 of the Mitchell Building or it can be deadheaded or mailed to you.

- **How Long?** The checkout period for each course is two weeks.

- **What's Available?** The course description of each course can be found on the VAS at guest\training\CT_Video\T3_VAS.rtf.

  If you are an Approach user you can check on the current availability of any course by accessing the read-only file on the VAS at guest\training\CT_Video\videodb.apr (password Montana).

- **How Much?** There is no charge.

**Course Code:** 3.04.01

**Course Title:** Remote LAN Access Technologies

The ability to access the corporate network from a remote location such as your home or while on the road is quickly becoming a fundamental part of today’s work environment. This course will begin with important concepts needed to understand any remote access implementation. Then, specific remote access solutions will be discussed. These include ISDN, ADSL and other DSL technologies, and Cable Modems. Topics such as how the technology works, equipment needed, standards, and implementation issues will be addressed. By the end of this course, the student will understand the many terms and concepts associated with Remote LAN Access today.

**Prerequisites:** You should take the T1 Digital Networks Course Series (3.02.01-3.02.05) and the LAN/WAN Internetworking Course Series (2.01.01-2.01.08) before taking this course.

**Technical Difficulty:** 1 2 3 4 5

Completion time: 2 hours (Video: 60 min + Workbook: 60 min)

For more information contact Trapper Badovinac of the Policy, Development & Customer Relations Bureau at 444-4917, ZIP! or e-mail at tbadovinac@mt.gov.
The Oracle Channel Training

The Oracle Channel Satellite education program is available to state agency staff through the ISD Data Network Connectivity fee. These broadcasts are held from 9:45 am to 2 pm in the Department of Transportation Information Services Bureau conference room (basement).

July
1 PL/SQL 8 New Features
8 Oracle8 Architecture & Startup
9 Oracle8 Architecture & Startup
14 Financial Applications Release 11 New Features
15 Manufacturing Applications Release 11 New Features
   *PREMIERE*
16 Object Technology Essentials
21 Introduction to Data Warehousing
22 Data Warehousing Fundamentals for DBAs
   *UPDATE*
23 Plan for Effective Data Warehouse Implementation
   *PREMIERE*
28 PL/SQL I: Coding Techniques
29 PL/SQL II: Database Level Application Programming

August
4 Discoverer:Analyze Your Data Requirements
   *UPDATE*
5 Designer/2000 Release 2 New Features
11 Oracle8 New Features
12 Oracle8 New Features
13 Oracle8 Performance Tuning Strategies
   *PREMIERE*
18 Oracle8 Data & Security Management
19 Oracle8 Backup & Recovery Strategies
20 Oracle8 Networking Strategies
25 Financial Applications Release 11 New Features
26 Manufacturing Applications Release 11 New Features

A full description for the each of the classes can be found on the Oracle website at http://education.oracle.com/education/toc. Because class material has to be ordered you must register at least two weeks before the scheduled class date. Please contact Barbara Clark at 444-0846, ZIP! or e-mail at baclark@mt.gov.

Training Calendar

Schedule assembled by the Helena College of Technology of the University of Montana. If you have any questions about enrollment, please call 406-444-6821. All classes will be held at the Helena College of Technology at 1115 N. Roberts.

Please note that these costs are subject to change July 1st. The Helena College of Technology makes reasonable accommodations for any disability that may interfere with a person's ability to participate in training.

Persons needing an accommodation must notify the college no later than two weeks before the date of training to allow adequate time to make needed arrangements. To make your request known, call 444-6821.

To enroll in a class, you must send or deadhead an enrollment application to the State Training Center, HCT, Helena, MT 59601. If you have questions about enrollment, please call 444-6821.

Once you enroll in a class, the full fee will be charged UNLESS you cancel at least three business days before the first day of class. HCT is also willing to schedule specific classes by request from state agencies.
# State Training Calendar

<table>
<thead>
<tr>
<th>Database Classes</th>
<th>PREREQ</th>
<th>DATE</th>
<th>COST</th>
<th>DAYS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intro. to Oracle</td>
<td>Intro to Windows</td>
<td>Fall 1998</td>
<td>200.00</td>
<td>2</td>
</tr>
<tr>
<td>Intro. to SQL</td>
<td>Intro to Oracle</td>
<td>Fall 1998</td>
<td>200.00</td>
<td>2</td>
</tr>
<tr>
<td>Oracle Developer 2000, part I</td>
<td>Intro to Oracle &amp; SQL</td>
<td>Fall 1998</td>
<td>**342.20</td>
<td>3</td>
</tr>
<tr>
<td>PL/SQL</td>
<td>Intro to Oracle &amp; SQL</td>
<td>Fall 1998</td>
<td>200.00</td>
<td>2</td>
</tr>
<tr>
<td>Oracle Developer 2000, part II</td>
<td>Oracle Dev. I &amp; PL/SQL</td>
<td>Fall 1998</td>
<td>**300.00</td>
<td>3</td>
</tr>
<tr>
<td>Oracle Designer</td>
<td>Oracle Dev. I; PL/SQL</td>
<td>Sept 14-25</td>
<td>**536.95</td>
<td>5</td>
</tr>
<tr>
<td>Access 97</td>
<td>Windows 95</td>
<td>July 14-15, Sept 3-4</td>
<td>200.00</td>
<td>2</td>
</tr>
<tr>
<td>Visual Basic for Applications</td>
<td>N/A</td>
<td>Sept 9-10</td>
<td>200.00</td>
<td>2</td>
</tr>
<tr>
<td>Query Crystal Reports</td>
<td>N/A</td>
<td>Aug 10, 11, 13</td>
<td>255.00</td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data Network/Mainframe Classes</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Seagate Backup Exec</td>
<td>N/A</td>
<td>Sept 22-23, Sept 24-25</td>
<td>150.00</td>
<td>apr 2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Microcomputer Classes</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 95 Conversion</td>
<td>familiar with Windows</td>
<td>July 6, Aug 11, Sept 2</td>
<td>50.00</td>
<td>1/2</td>
</tr>
<tr>
<td>Windows 95</td>
<td>N/A</td>
<td>July 1, Aug 3, Sept 1</td>
<td>100.00</td>
<td>1</td>
</tr>
<tr>
<td>ZIPIOffice</td>
<td>N/A</td>
<td>Sept 11</td>
<td>FREE</td>
<td>1/3</td>
</tr>
<tr>
<td>WordPerfect 6.1 for Windows</td>
<td>Windows 3.1 or 95</td>
<td>Aug 4</td>
<td>100.00</td>
<td>1</td>
</tr>
<tr>
<td>Word 97 Conversion</td>
<td>Windows 95</td>
<td>July 20, Aug 11, Aug 19, Sept 10</td>
<td>50.00</td>
<td>1/2</td>
</tr>
<tr>
<td>Word 97 for Light Users</td>
<td>Windows 95</td>
<td>July 16, Aug 5, Sept 9</td>
<td>100.00</td>
<td>1</td>
</tr>
<tr>
<td>Word 97</td>
<td>Windows 95</td>
<td>July 7-8, 14-15, 28-29, Aug 13-14</td>
<td>200.00</td>
<td>2</td>
</tr>
<tr>
<td>Lotus for Windows</td>
<td>Windows 3.1 or 95</td>
<td>Aug 10</td>
<td>100.00</td>
<td>1</td>
</tr>
<tr>
<td>Excel 97 Conversion</td>
<td>Windows 95</td>
<td>July 20, Aug 12, Aug 19, Sept 10</td>
<td>50.00</td>
<td>1/2</td>
</tr>
<tr>
<td>Excel 97 for Light Users</td>
<td>Windows 95</td>
<td>July 17, Aug 6, Sept 14</td>
<td>100.00</td>
<td>1</td>
</tr>
<tr>
<td>Excel 97</td>
<td>Windows 95</td>
<td>July 9-10, Aug 17-18, Sept 17-18</td>
<td>200.00</td>
<td>2</td>
</tr>
<tr>
<td>PowerPoint 97</td>
<td>Windows 95</td>
<td>July 22-23, Sept 15-16</td>
<td>200.00</td>
<td></td>
</tr>
</tbody>
</table>

Prerequisites may be met with consent of Instructor.

** The Oracle Designer and Developer class fees are recovered through the monthly data network rate and paid for by ISD.
State Training Enrollment Application

Complete IN FULL and return AT LEAST ONE WEEK prior to the first day of class.

Course Data
Course Request____________________________________________________
Date Offered______________________________________________________

Student Data
Name____________________________________________________________
Soc. Sec. Number (for P/P/P)________________________________________
Agency & Division_________________________________________________
Mailing Address___________________________________________________
Phone_____________________________________________________________

How have you met the required prerequisites for this course? Explain, giving the class(s) taken, tutorial completed, and/or experience.

_________________________________________________________________

Billing Information/Authorization Mandatory
LogonID _____ Agency# _____ Authorized Signature______________________

If attending Oracle Developer or Designer training, your application must also be approved by the agency IT Manager.
IT Manager _______________________________________________________ 

Training is needed for
☐ Agency Oracle Developer
☐ Continuing education opportunity (Agency will be billed for training.)
☐ Agency contractor (Agency will be billed for training.)

Full class fee will be billed to registrant unless cancellation is made three business days before the start date of the class.

DeadHead completed form to
State Training Center, Helena College of Technology of the U of M
Phone 444-6800 FAX 444-6892
Published monthly by
Information Services Division (ISD)
Department of Administration
Room 229, Mitchell Building, Helena, MT 59620
406-444-2700  FAX 406-444-2701

This newsletter is dedicated to educating and informing with pertinent State technology news. Materials may be reproduced without permission by referencing ISD News & Views and the month it was printed.

Alternative accessible formats provided upon request.

FREE Subscription
Please contact Lois Lebahn, via ZIP!, if you would like to receive ISD News & Views, or if your mailing information is incorrect. Include your name, agency, division, bureau, phone, address, city, state, and zipcode.

Available in Various Formats
- ISD Box #, Deadhead or Mail
- ZIP!/ZIP!Office or VAX e-mail
- www.state.mt.us/isd/current/news
- ISD’s Value Added Server\guest\N&V

To Submit an Article
Send the article to Trapper Badovinac, via e-mail. The deadline for inclusion in the following month's newsletter is the 1st week of the previous month.

Printing & Distribution
810 copies of this public document were printed at a cost of $600. Distribution costs are $18.25. 128 copies were distributed electronically at no cost.

Contacts & Editor
Editor: Trapper Badovinac (444-4917), ZIP! or e-mail at tbadovinac@mt.gov.
Layout: Diana MacDonald (444-3170), ZIP! or e-mail at dmacdonald@mt.gov.
Subscription: Lois Lebahn (444-2700), ZIP! or e-mail at LLebahn@mt.gov.

ISD Customer Support Center
Available for any problems or opportunities you may have. (444-2000)

www.state.mt.us/isd/current/news